Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOW®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, RIVA, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔴</td>
<td>Caution</td>
</tr>
<tr>
<td>💬</td>
<td>Example</td>
</tr>
<tr>
<td>📝</td>
<td>Note</td>
</tr>
<tr>
<td>🧪</td>
<td>Recommendation</td>
</tr>
<tr>
<td>⌛</td>
<td>Syntax</td>
</tr>
<tr>
<td>💡</td>
<td>Tip</td>
</tr>
</tbody>
</table>
Enterprise Modelling – Consultant’s Handbook
Enterprise Modeling

Purpose

One of the first steps in configuring an R/3 System is mapping and modeling the organizational structure of an enterprise using the organizational units in the R/3 System. This section does not cover technical aspects of this process in the R/3 System.

Enterprise modeling aims to plan and represent the basic structure of all R/3 System components, taking into account strategic business processes, information flows, distribution scenarios and R/3 business objects. An enterprise model portrays the structure of an enterprise using the organizational units in the R/3 System. You may use it to evaluate the usability of an R/3 System that has been configured in accordance with an enterprise’s business requirements.

You can use the Structure Modeler to graphically portray enterprise models. You can also involve user departments and management at an early stage of the project. Users do not need in-depth knowledge of the R/3 System. This provides a binding framework for the entire project phase, increasing stability when implementing your R/3 System. This also reduces the likelihood of having to revise key organizational decisions after a prototype has been configured, that is, after a project has been running for a long time.

This handbook is intended for members of the integration planning team involved in the implementation of R/3. These are, in particular:

- Project managers
- Members of the core project team
- Certain members of the specialist departments
- Consultants.

This handbook aims primarily to support the planning process for implementing the R/3 System in larger groups. Many of the issues discussed here may be clarified more easily and quickly in small- and medium-sized enterprises than in large enterprises. By giving due consideration to the subjects discussed here, however, even smaller and medium-sized enterprises can benefit from greater reliability with regard to system planning.

Integration

The tasks involved in organizational modeling are incorporated in SAP’s standard implementation methodology AcceleratedSAP (ASAP) and in Global ASAP.

You can find information on the relevant procedures in the pertinent work packages in the ASAP Implementation Guide and in Global ASAP.

Features

Several alternative enterprise models are drawn up at an early stage of the project or during a groupwide study conducted before the project starts based on enterprise model patterns (structure scenarios). You should answer the following questions when you evaluate these enterprise models:

- Is all of the information required for strategic decisions or for the daily operation of the enterprise available in a suitable form?
- Are all of the core business processes supported?
In order to show you just how useful structure scenarios are, this handbook contains an example of how the structure of a fictitious company is mapped (business area scenario, company code scenario and profit center scenario).

**Constraints**

Some of the subject matter addressed here is extremely complex; therefore, the following sections focus on key aspects. Rather than providing specific guidelines for action, this handbook aims to provide basic knowledge for enterprise modeling and for using SAP concepts and tools.

Users should, therefore, not apply the content of this handbook in an enterprise without first receiving additional, intensive consultation from an SAP-certified consultant. SAP AG does not accept liability for the contents of this handbook.
Structure of the Enterprise Model

Purpose

Before you map models of enterprise structures, you must identify and assign the components of an enterprise. You must also be familiar with the organizational structures in the R/3 System, the way they interact technically and the possibilities for displaying structures in order to portray enterprise-specific structures in organizational structures in the R/3 System.

In this context, the R/3 System organizational units described in the following sections are particularly important.

Procedure

To create an enterprise model, follow these steps:

1. Developing a Cross-Component Concept [Page 11]
2. Determining Strategic Goals [Page 13]
3. Depicting the Enterprise Structure [Page 15]
4. Depicting the Management Structure [Page 18]
5. Defining Reporting Requirements [Page 19]
Developing a Cross-Component Concept

Use

If you want to implement specific components of the R/3 System, you must define the organizational units of a component in line with the requirements of the specific application area.

If, for example, you implement the component *Financial Accounting* (FI) first, the organizational unit company code is set up in accordance with the requirements of *Financial Accounting* and external accounting. If you implement other components of the R/3 System at a later stage, you may have to redefine the company code structure in order to meet different requirements.

To avoid unnecessary changes in the organizational structure of an R/3 System, it makes sense to develop an organizational concept for the entire R/3 System before configuring the different application components.

Integration

When you are developing a cross-component, organizational concept take reporting, business process, master data and legal requirements into account. Select the cross-component business processes on the basis of the organizational concept. The components are then configured based on these business processes.

Select the concepts for the organizational structure and the R/3 business processes on the basis of the integration requirements of the entire system. When you configure components account
Developing a Cross-Component Concept

the R/3 System takes account of detailed requirements of the different application components in the R/3 System.
Determining Strategic Goals

Use

Certain factors – like increased competition in the industry, or changes in core processes – force the enterprise to define new goals and put them into action. This definition of new or altered strategic goals often takes place during the implementation of an R/3 System.

The aim of any R/3 implementation in an enterprise is to optimize the entire business system, or at least those parts of it that are crucial to the enterprise.

Integration

The strategic goals defined at the start of the implementation project affect the application components that form the system:

- The enterprise structure (organizational structure)
- The business processes (process structure)
- Information management

The interdependence of these components may mean that business processes need to be adjusted and information flows need to be redefined, when the business processes of the enterprise are being re-engineered.

The effect of strategic goals on organizational processes and structures
Determining Strategic Goals

The strategic goals of an enterprise form the basis for defining the main tasks faced by an enterprise. The enterprise needs to use the strategic goals it has defined for itself to derive appropriate business processes and organizational structures.

Strategic Information Requirements
The strategic goal of an enterprise is to become the leader in a particular market segment. To reach this goal, the enterprise needs a cost accounting system that provides information at a glance.

Questions to ask:
What do we need to do to create an efficient cost accounting system? (question on what business processes are appropriate)
Where do we need to do it? (What organizational structures are appropriate)?

Solution strategy
If you want a cost accounting system that provides information at a glance, it may make sense to collect all the relevant cost-accounting data created during Logistics processes, in profit centers. In these profit centers, the Logistics processes can be analyzed and the acquired data compressed to strategic information (ROI, and so on).

This analysis may show that it is not possible, using existing business processes and organizational structures, to become cost leader in the market. If so, then either the business processes and organizational structures or the strategic goal itself must be changed.
Depicting the Enterprise Structure

Definition
Enterprises are economic units whose structure has often developed in an evolutionary way, becoming extremely complex through the enterprise’s history through acquisitions and expansion.

An enterprise can consist of several legally independent companies, for which you need to create individual financial statements at the end of the year.

Structure
To set and then achieve your objectives, you need an adequate structure. Generally, there are two main types of enterprise structure:

- Vertical enterprise structures [Page 16]
- Horizontal enterprise structures [Page 17]

The activities of a business unit can be distributed among several individual companies.
The location of an enterprise can be used by several companies and different business units.
Defining Vertical Enterprise Structures

Definition
Enterprises that are structured vertically are organized internally on the basis of the markets to which they supply their products.

Structure
These enterprises often have a large product range, and sell pre-products from different points in the value chain.

- Services
- Made to order/repetitive manufacturing products
- Internal/external products

Integration

Market segments with a similar customer structure (vertical orientation) or products with similar technology or sales markets (product orientation) can be grouped together to form strategic business units. These business units or subdivisions are often controlled using results targets.
Determining Horizontal Enterprise Structures

Definition
Horizontally structured enterprises focus on the production process - from development to production to sales and marketing.

Use
Key figures for controlling the individual organizational units are based largely on cost targets; rather than results targets. These enterprises are structured according to function – for example, acquisition, production, R&D, and so on.

Structure
They often produce a small number of repetitive manufacturing products in a large number of variants. The production processes are complex and highly interdependent; they include processes from several different stages in the product life cycle.

The enterprise areas of a horizontally structured enterprise:

- Procurement
- Production
- Sales and distribution
Depicting the Management Structure

Definition
You can use the management structure of the enterprise to define the factors that are most important in determining internal organization.

Structure
If management is structured by enterprise area (purchasing, production, sales, and so on) and if responsibility for these business units is divided among several management executives, the main view of the enterprise is process-oriented, or horizontal.

Conversely, if the management of the business is structured by strategic business unit, and the responsibility for the results from the different business units is clearly assigned to individual executive areas, the main view of the enterprise is vertical.

Many enterprises contain both horizontal and vertical management structures.

Vertical management is responsible for the markets it supplies (customer groups, application areas, and so on) and for the revenues generated, while production management is responsible for production processes and the costs they incur.
Definition of Reporting Requirements

Use

Different organizational units can have very different reporting requirements.

For the legal units of an enterprise (companies), there are legal requirements for reports that describe the enterprise’s periodic success and the general economic situation.

No legal requirements exist, however, for reports that pertain to the strategic business units of an enterprise. Internal reports are based on the requirements set by those who control the strategic and operative side of the business unit.

Integration

In the R/3 System, organizational structures control business processes using master and control data. The business processes supply data back to the organizational units as a by-product of the individual process steps. This data can be summarized at the level of different organizational units (operating concern, business area, profit center, and so on) to form different types of strategic information (balance sheets, profitability analyses, and so on).

Typical report requirements for strategic business units or their subdivisions include:

- Balance sheet and income statement
- Balance sheet reference numbers (capital returns, operating result, and so on)
- Contribution margins
- Development of revenues for new product lines
Organizational Units

The following is a list of all organizational units grouped by area:

- Cross-application
- Accounting
- Logistics
- Human Resource Management

For some of these texts you can display further information, while others are defined in the R/3 Glossary.

**Cross-application**

- General
  - [Enterprise [Ext.]]
  - [Work center [Ext.]]
- System infrastructure
  - Physical R/3 System
  - Logical System

**Accounting**

- Financial Accounting
  - [Company [Ext.]]
  - [Company code [Ext.]]
  - [Consolidation business area [Ext.]]
  - [Business area [Ext.]]
  - [Functional area [Ext.]]
  - [Consolidation group [Ext.]]
  - Consolidation entity
  - Taxes on sales or purchases group
  - Credit control area
  - Dunning area
  - FM area
  - Funds center

**Controlling**

- [Controlling area [Ext.]]
- Cost center group
- Cost center
- [Operating concern [Ext.]]
Organizational Units

- Profit center grouping
  - **Profit Center [Ext.]**

**Logistics**
- Logistics (general)
  - Design office
  - **Plant [Ext.]**
  - Storage location (plant storage areas)
- Sales and distribution
  - **Sales organization [Ext.]**
  - Sales Area
  - **Distribution channel [Ext.]**
  - **Division [Ext.]**
  - Sales office
  - Sales group
  - Shipping point
  - Loading point
  - Transportation planning point
- Materials Management
  - **Material valuation area [Ext.]**
  - **Purchasing organization [Ext.]**
  - Purchasing area
  - **Purchasing group [Ext.]**
- Warehouse management
  - Warehouse complex
  - Warehouse
  - Storage bin
  - Storage area
- Plant maintenance
  - Maintenance planning plant
  - Maintenance plant
  - Maintenance planning group
  - Functional location
- Production planning and control
Organizational Units

- Work scheduler group
- Capacity group
- CAPP planner group
- MRP group
- Production scheduler group
- Production responsibility group
- Supply area

Human Resource Management

- Personnel area
- Personnel subarea
- Employee group
- Employee subgroup
- Payroll accounting area
- Organizational plan unit
- Job (planned)
- Job
Mapping the Enterprise Structure in the R/3 System

Purpose

You need to bring your business and legal requirements into line with the technical system requirements, by mapping the organizational structure of your enterprise to the organizational units of the R/3 System.

Prerequisites

To create the enterprise structure in the R/3 System, you must be familiar with:

- The interaction between the R/3 structure elements – business processes, organizational units, and information
  See also The Organizational Structure of R/3 Applications [Page 24]
- The organizational units of the R/3 System, along with the fixed rules that apply to them, and the ways they can be used— for example for process control or reporting.
  The Organizational Structure of an R/3 System [Page 25]

Procedure

1. Portraying the Enterprise Structure [Page 27]
   Later, the Project Managers can define the system topology of the enterprise, based on the organization’s requirements, and the possible ways in which they can be mapped. This topology can consist of one central R/3 System or several linked R/3 Systems.

2. Process Control [Page 28]

3. Determining Master Data [Page 29]

4. Definition of Reporting Options [Page 30]
The Organizational Structure of R/3 Applications

Definition
R/3 applications consist of:

- Business processes
  Business processes are described in the R/3 Reference Model.

- Organizational units/business objects
  Organizational units/business objects and the relationships between them are described in the Business Object Repository. In R/3, organizational units control business processes and information flow using master and control data.

- Information

Integration
As the following graphic shows, the emphasis on these elements is different in the different business areas (Accounting, Logistics, and Human Resource Management).

In Accounting, the focus is on acquiring information for internal and external reporting requirements. In Logistics, business processes are of decisive importance. In Human Resource Management, business processes and information are equally important.
The Organizational Structure of an R/3 System

Definition
One of the first steps in the implementation of the R/3 System involves mapping the structure of the respective enterprise onto the organizational units of R/3. This structure mapping must ensure that

- all business processes can run smoothly, using resources as efficiently as possible
- the requirements for internal and external reporting are met

Use
Different types of organizational units are available in the R/3 System to represent enterprise structures in the system.

- The R/3 System
- Operating concern
- Controlling area
- Business area
- Company code
- Plant

When you implement the system, you must set up as many organizational units as you need. You then map the enterprise structures to the organizational units.

Mapping the organizational units to the R/3 organizational units could look like this, for example:

<table>
<thead>
<tr>
<th>Business Structure Elements</th>
<th>R/3 organizational units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise</td>
<td>The R/3 System</td>
</tr>
<tr>
<td>Company</td>
<td>Operating concern</td>
</tr>
<tr>
<td></td>
<td>Controlling area</td>
</tr>
<tr>
<td></td>
<td>Company code</td>
</tr>
<tr>
<td>Business unit</td>
<td>Business area</td>
</tr>
<tr>
<td>Business location</td>
<td>Plant</td>
</tr>
</tbody>
</table>

A central R/3 System is set up for enterprise in which all the functions for Accounting and Logistics are mapped.

Profitability analysis is executed in an operating concern. Cost center and cost element accounting take place in a controlling area. Business areas allow the creation of internal balance sheets for the business units. A company code controls the financial accounting area and represents the company in the legal sphere.

Locations are represented by plants.
Portraying the System Infrastructure

Definition
You draw up a logical concept in order to determine an enterprise’s cross-system and cross-client structures, information flows and business processes. This concept provides a basis for Customizing in the R/3 System.

Use
In general, you may portray your enterprise’s structures in one or in several R/3 systems.

One R/3 System
It is not necessary to represent the individual economic units of an enterprise by independent, linked R/3 systems.

By representing an enterprise in a central R/3 System, you may maximize integration of the business processes and information flow required.

Several R/3 Systems
Reasons for distributing the logical concept across several R/3 Systems include:

- Technical facts such as performance, availability, maintenance, upgrade:
- An enterprise’s regional structures
  The availability of the data for external reporting requirements (taxes, balance sheets) as well as control of the financial accounting functions are the most important business requirements that have to be met.
- An enterprise’s structures are geared towards business units
  The prerequisite for this is that business requirements focus either on logistical integration within the business units or between different companies in the group.
  Reporting requirements in Financial Accounting should focus on the cost and profitability analysis for each business unit.

There are many different ways of designing system infrastructures, ranging from a regional to a business-unit-oriented system topology. As a rule, an enterprise’s system infrastructure constitutes a combination of these two approaches.

When implementing distributed R/3 Systems, you may choose between different distribution techniques, such as ALE or the Ledger Roll-Up technique of the application component FI-SL (Special Ledger).

For more information, see:
ALE Integration Technology [Ext.]
Process Control

Definition

In the R/3 System, organizational units use master and control data to control functions and processes. When you implement the R/3 System, make sure that the required business processes are supported by the organizational structure you have selected.

Use

Many processes are controlled by more than one organizational unit. Other business processes, however, are controlled by one specific organizational unit.

- Company codes control payment transaction processes.
- Plants control production planning and control processes.
- Sales organizations control sales processes.
Determining Master Data

Definition
Master data contains information that is used frequently in the same manner in certain processes.

Use
You define generally valid master data items at client level for several applications. You can add application-specific data to general master data at organizational-unit level.

You use information such as addresses, telephone and fax numbers to communicate with customers, for example, in the components Financial Accounting and Sales and Distribution. You can store this information for several applications at client level.

You define application-specific customer master data, such as bank account numbers in the Financial Accounting component or the pricing plan in the Sales and Distribution component, at the level of application-specific organizational units (company code and sales area).
Definition of Reporting Options

Definition
Reports and evaluations created in R/3 are generally structured by organizational unit.

Use
When you define the organizational structure, you must bear in mind that the different organizational units in R/3 provide very different reporting options.

<table>
<thead>
<tr>
<th>Reports on these elements</th>
<th>Are based on:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company codes</td>
<td>External reporting requirements (balance sheet,</td>
</tr>
<tr>
<td>Companies</td>
<td>profit and loss statements)</td>
</tr>
<tr>
<td>Subgroups</td>
<td></td>
</tr>
<tr>
<td>Controlling areas</td>
<td>Cost structure of the enterprise subgroups.</td>
</tr>
<tr>
<td>Operating concerns</td>
<td>Results structure of the market segments that</td>
</tr>
<tr>
<td></td>
<td>are supplied with products or services.</td>
</tr>
</tbody>
</table>

Summarizing information in Logistics and Accounting is based on three information flows:

- **Accounting (internally)**
  Information created automatically during business processes can be summarized within accounting.
  
  Clearing open items in accounts receivable can affect the payment history details of certain customers.

- **Logistics**
  Within Logistics, information flows deal mainly with data on quantities, volumes or times.
  
  Material withdrawals for a customer order from a storage bin affect the information on the availability of that material.

- **Cross-application**
  Value-relevant information from Logistics (material stock, orders, revenue, and so on) must be transferred to the Accounting system, so that you can then extract information of strategic importance – for example, balance sheets or profitability analyses. This is made possible using cross-application information flows. This information flow process is controlled by allocating organizational units in Logistics to organizational units in Accounting.
From the assignment of a plant to a company code, you can find out the G/L accounts within a business unit or legal entity to which material stock changes within the plant are to be posted.

The Logistics data is then linked to the Accounting data.

In profitability analysis, cost information transferred from cost center accounting is merged with information on sales revenues. Using this information you can determine the contribution margin of individual market segments.
Strategic Business Units

Definition

Strategic business units are the smallest units of an enterprise to which you can assign certain markets and the capital used to supply these markets.

Use

Keep the following aspects in mind when you select organizational units in the R/3 System to represent the strategic business units of an enterprise:

- How is the value-added process of the enterprise organized?
- What is the relationship between the strategic business units?
- Which reporting requirements exist for strategic business units?
- To what extent are core processes in Logistics (customer order processing, procurement, and so on) or Financial Accounting (payment transactions, credit control, and so on) separated according to strategic business units?

The type of value added and the relationship between the strategic business units can provide information on the future strategic development of an enterprise.

You should anticipate future strategic development and choose the appropriate organizational structure in the R/3 System. You have to clearly define each strategic business field and determine to what extent each field is independent of the others.

When you portray strategic business areas, you may choose from the following options in the R/3 System:

- Business area scenarios [Page 34]
- Company code scenarios [Page 35]
- Profit center scenarios [Page 36]

If companies in a group are loosely linked, you can use clients instead of the company code to represent strategic business fields. You can also use a client-specific concept to portray groupwide scenarios, for example, e-commerce.

You can choose aggregation levels for the above-mentioned organizational units (basic organizational units).

<table>
<thead>
<tr>
<th>Basic organizational units</th>
<th>Aggregation levels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company codes</td>
<td>Companies, subgroups</td>
</tr>
<tr>
<td>Business areas</td>
<td>Consolidation business areas, consolidation groups</td>
</tr>
<tr>
<td>Profit center / cost center</td>
<td>Profit center groups</td>
</tr>
</tbody>
</table>

These basic organizational units control business application functions and business processes for business-area-specific accounting in the R/3 System.

For the purpose of reporting and consolidation, you can consolidate the basic organizational units at aggregation level.
The R/3 System contains the following organizational units to control operative functions in the Logistics component:

- Plants
- Sales organizations
- Purchasing organization

When you decide on an organizational concept for the R/3 System, the strategic business units can be of similar importance as the legal entities of the enterprise.

The segmenting of these business units is of considerable importance for the strategic and operative management of the company. Critical success factors, core competence factors, and market segments are specific characteristics of each strategic business unit.

Reporting requirements and business processes are often set uniformly within a strategic business unit in order to reduce the complexity of the business procedures. If this is the case, the companies within a group only supply services, for example, to support the operative running of the strategic business units and fulfill the requirements for external rendering of accounts in the respective company location.

Capital yield plays a special role in the strategic management of the business units. It is usually not enough to manage the business units based on sales or turnover quantity since interest on the capital used is not taken into account, that is, the long-term revenue and investment potential of the company is not necessarily guaranteed.

Alternatively, you may use software products such as the Business Warehouse to calculate expected product-specific income.
Business Area Scenarios

Definition

In business area scenarios you set up a business area for each strategic business unit in an enterprise. Legally-independent enterprises are represented by a company code.

Use

The following graphic shows a section of the organizational structure of an R/3 system for an enterprise that consists of three legally-independent companies and is active in three strategic business units.

A company code has been set up for each legally-independent company. Strategic business units are represented by business areas. Each strategic business unit is active in all three legally-independent companies, that is, you can assign all three business areas to all company codes.

For more information about the graphic, see Portrayal in the Structure Modeler [Page 38].
Company Code Scenarios

Definition

In company code scenarios, each intersection of a strategic business unit with a legally-independent company is represented by a company code. Strategic business units that have activities in several legally-independent companies have several company codes.

Use

The following graphic displays part of the organizational structure of an R/3 System for an enterprise that consists of three legally-independent companies and one strategic business unit.

If an enterprise has several strategic business units, a company code is set up for each intersection of a strategic business unit with a legally-independent company.

The R/3 System draws up business area balance sheets by consolidating figures vertically and balance sheets for legally independent companies by consolidating figures horizontally.

For more information about the graphic, see Portrayal in the Structure Modeler [Page 38].
Profit Center Scenarios

Definition

Profit-Center [Ext.] scenarios use profit centers to display strategic business units. Profit centers may cover more than one legally independent organizational unit.

Use

The main difference between profit centers and business areas is that profit centers are used for internal management whereas business areas are geared more towards external purposes.

Whereas profit centers use key figures such as return on investment and profit-sales ratio to evaluate performance, business areas focus on balance sheets and profit and loss statements.

A typical profit center could look as follows:

For more information about the graphic, see. Portrayal in the Structure Modeler [Page 38].

It makes sense to represent strategic business units as profit centers if

- Technologies and business processes used in different business units for value-added purposes are more or less standard
- The markets of the various business units have a uniform structure
- It is not planned to exclude individual business areas for legal reasons
- Transfer prices are used when processing material or service transactions between business areas.
- It is likely that strategic business areas will be restructured or changed regularly.
Several hierarchical structures (profit-oriented, functional, regional and so on) are required.

The most important operational requirements for strategic business units are centered around reporting,

Information systems, assignments and planning are to be used more flexibly.
Portrayal in the Structure Modeler

Use

One step in an R/3 implementation is mapping the structure of your enterprise onto the R/3 System organizational units. The goal is to create structure scenarios that are an accurate reflection of the enterprise being modeled and are also consistent with the organizational structures, business processes and reporting facilities provided by the R/3 System.

The R/3 System organizational units play a key role in:

- How business processes are carried out
- What information is generated (internal and external reporting)
- How R/3 functionality is distributed among different systems.

You may use the Structure Modeler to represent in a graphic form the instances of the R/3 System organizational units you have chosen to reflect the enterprise's particular requirements. This facilitates discussion about alternative structure scenarios.

The Structure Modeler graphically displays organizational structures. It does not have any technical links to the R/3 System, so it does not automatically check that your structure scenarios are consistent or complete. The person who draws up the structure scenarios is responsible for ensuring that the organizational units and their relationships are correct and complete. He/she must check that the model corresponds with the business context in the R/3 System.

This handbook focuses on the concept and the functions of the Structure Modeler and does not describe Visio functions.

The Structure Modeler is incorporated in ASAP and Global ASAP, SAP's methodology for implementing the R/3 System. The relevant work packages refer specifically to the tool. For more information on using the Structure Modeler in ASAP and Global ASAP see Enterprise Modeling Procedures [Page 106]
Before You Start

In order to use the Structure Modeler efficiently to implement the R/3 System, it is important that you understand

- how the R/3 organizational units are structured
- the relationships between these organizational units
- how you may use the Structure Modeler to portray your enterprise structure.

The following sections describe the different types of relationships and how they are portrayed in the Structure Modeler.
System for Portraying Structure Scenarios

Use

The Structure Modeler allows you to portray your business structure scenarios using tiles.

Features

Each instance of an organizational unit in the R/3 System is visualized as a colored tile. Tiles representing instances of the same R/3 System organization unit share the same color.

The illustration shows the tiles used for the selected R/3 System organization units. You look at the enterprise structure and the system infrastructure together, so you portray both the physical R/3 System and the clients.

Activities

You give each instance you would like to portray in the graphic its own tile.

You arrange the tiles to reflect the relationships between these instances.

You usually use the tiles to model specific views of structure scenarios, for presentations for example. You may model specific views of structure scenarios by portraying selected organizational units. For example, you could portray three of twenty companies in the group. You may also portray specific views of structure scenarios by building a comprehensive model of R/3 organizational units. Each view only contains the instances of R/3 organizational units that are important for you. An instance of a System organizational unit can appear in several views. For
example, the company code is important both in a consolidation view and in a logistics view. The consultant responsible must ensure that the contents of the model are correct.

Useful views include:

An accounting view [Page 42]
A consolidation view [Page 43]
A sales view [Page 44]
A logistics view [Page 45]
An Accounting View

This view shows instances of the following R/3 System organizational units:

- Client
- Operating concern
- Controlling area
- Company code
- Business area

Example:
A Consolidation View

This view shows instances of the following R/3 System organizational units:

- Consolidation entity (group, subgroup)
- Consolidation unit (company)
- Company code

Example:
A Sales View

This view shows instances of the following R/3 System organizational units:

- Company code
- Sales organization
- Distribution channel
- Division
- Sales area

Example:
A Logistics View

This view shows instances of the following R/3 System organizational units:

- Company code
- Plant
- Sales organization
- Purchasing organization

Example:
Relationships Between R/3 System Organizational Units

Definition
In the tile portrayal, the arrangement instances of the R/3 System organizational units reflect the relationships between the organizational units in the R/3 System.

Use
Relationships cover not just Customizing relationships where there is a hierarchical assignment of organizational units. Some relationships have a business basis and others originate in the R/3 System.

Structure
Types of relationship:
- An interaction of some form exists between instances:
  - Relationships with a defined direction [Page 47]
  - Relationships with no defined direction [Page 49]
  - ALE connection [Page 54]
- There is no interaction between instances:
  If there are no direct relationships between two instances of one or different R/3 organizational units, these instances are portrayed in the tile portrayal without direct contact points.
Relationships with a Defined Direction (Directed)

Definition
A directed relationship exists between a pair of instantiated R/3 System organizational units if one of the instances is functionally dependent on the other.

Use
Examples of relationships with a defined direction follow:

- One or more company codes are assigned to a client (logical system). A company code is defined in exactly one client (1:n relationship; the company code is the dependent organizational unit).

- An operating concern can contain several controlling areas. Conversely, a controlling area can only be assigned to exactly one operating concern (c:cn relationship; the controlling area is the dependent organizational unit).

- Each controlling area can have one or several profit centers assigned to it. Conversely, a controlling area can only be assigned to exactly one operating concern (c:cn relationship; the controlling area is the dependent organizational unit).

- One or more operating concerns can be defined in a client (logical system). A controlling area can be assigned to exactly one logical system (1:cn relationship; the controlling area is the dependent organizational unit).

If there is a directed relationship between entity types belonging to two different R/3 System organizational units, instances of the dependent organizational unit are placed on top of instances of the independent R/3 System organizational unit. This means that the dependent organizational unit instance is placed within the boundaries of the independent organizational unit instance.

The tile that represents the operating concern is placed on top of the tile that represents the client in which the operating concern is defined. The operating concern tile is completely within the boundaries of the client tile.
Relationships with no Defined Direction (Non-Directed)

Definition
A relationship with no defined direction between a pair of R/3 System organizational units is chosen when it is impossible to determine which instance is dependent on the other.

Use
Examples of relationships with no defined direction follow:

- A sales organization can sell materials from different divisions assigned to it. It is also possible for several sales organizations to sell materials from one division (cn:cm).
- A sales organization can use several distribution channels to sell materials. A distribution channel can be used by several sales organizations (cn:cm).
- Business areas and company codes can be installed within one client (logical system) but can be defined independently. Posted values from accounting in a single company code may be assigned to different business areas. The business area can be inferred from information gathered in business cases (for example, deriving the business area from materials, plant or cost center information about goods receipts) or may have been entered manually.

In the following examples it is not possible to declare one unit to be dependent on the other. There are two alternative ways of portraying this. The two portrayals and their respective merits are explained in the following sections:

Portrayal 1 [Page 50]
Portrayal 2 [Page 52]
Portrayal 1

The tiles representing the instances that are related to each other are stacked at right angles and overlap each other. Since there is no defined direction, you decide the order to stack the tiles. This section provides examples of different tile portrayals.

![Diagram showing the overlap and stacking of tiles to represent organizational units.]

This portrayal is useful in cases where one instance of an R/3 System organizational unit has relationships with several instances of another R/3 System organizational unit and if the intersection of the overlapping tiles provides further context. The following example shows how this can be used to good effect.

The tiles below illustrate how meaningful relationships between company code, sales organization, and divisions can be represented.
There are several possible reasons for choosing this portrayal:

- You may define divisions for more than one company code, but you can only assign a sales organization to one company code. Sales organizations may sell materials from several divisions. You may display both relationships in graphic form.
  - Place the tile that represents the sales organization on top of and within the tile that represents the company code to which the sales organization is assigned.
  - If a sales organization sells materials from a division, the tile for the division should overlap the tile for the sales organization.

- A sales area is set up for each valid combination of division, distribution channel and sales organization.
  - To represent the sales area and its assignments in graphic form, it is best to place distribution channels and divisions orthogonally to the sales organizations. Sales areas can then be placed over the intersections.
Portrayal 2

The use of lines between tiles is an alternative method of depicting relationships with undefined direction between instances of a structure scenario.

This method is useful when the first kind of portrayal would result in a diagram that is too complicated, or when the resulting overlaps would have no bearing on the current structural issues.

The tile representation below uses lines to depict a relationship between plants and purchasing organizations.
Company code purchasing organization

Plant purchasing organizations

Plants
ALE Connection

Definition
As you model the structure, you should bear the system infrastructure in mind. Options for distributing enterprise data to R/3 depend on how you allocate R/3 System organizational units to R/3 Systems.

Use
In system distribution scenarios, the instances of R/3 System organizational units are defined in the main system and then distributed to the local systems. This means that the local systems will run a copy of the main instance, which is still located in the main system.

- For cross-system financial statements, the local systems hold copies of the operating concern which was defined in the main system.
- For cross-system cost accounting, the local systems hold copies of the controlling area which was defined in the main system.

In the tile portrayal, copies of an instance are denoted by a prefixed C. This signifies that the original instance will be distributed. Additional arrows show the direction of the data flow.

ALE connections can be documented by adding information concerning the type of data exchanged (IDOCs / BAPIs required). This information can be written next to the arrows or in the pertinent documentation file.
The Arrangement of R/3 Organizational Units Displayed

Definition

There is a predefined order for stacking the tiles of a structure scenario. This order is partly due to R/3 business rules, in other words, the order is a result of the dependencies that hold between the various R/3 system organizational units, and partly due to convention. Model the R/3 system organizational units in this defined order.

R/3 Organizational Units within the System Infrastructure

The physical R/3 System and the logical system (client) are the same across the applications.

All R/3 System organizational units described in this section are dependent on the client (the logical system), which depends in turn on the physical R/3 System. For clarity, the directed relationships are not shown in the following sections.

In the following section the organizational units are combined into groups and an overview of the dependencies that exist between them is depicted. The section is from the SAP Enterprise Data Model, which shows selected dependencies. More information on relationships between organizational units can be found in the SAP Enterprise Data Model and in the Business Object Repository.

Selected Organizational units for Accounting
The Arrangement of R/3 Organizational Units Displayed

Selected Organizational units for Consolidation
Selected Organizational units for Logistics
In the Structure Modeler selected R/3 system organizational units have their own shapes. The Structure Modeler also includes a "dummy organizational unit" that can be used for any other organization unit.

There are plans to increase the number of available shapes for organizational units in the Structure Modeler. In particular, organizational units that often take on strategic importance in an enterprise-specific context will be considered.

A list of R/3 organizational units can be found in the SAP Enterprise Data Model and in the Business Object Repository.
R/3 System Organizational Units with Their Own Shape

Definition

The following sections contain an introduction to each R/3 system organizational unit that currently has a shape in the Structure Modeler. The term shape here refers to an instance of an R/3 organizational unit. The relative positions of these shapes represent the relationships between the instances.

Use

The following section provides an example of R/3 organizational units with their own shape.

A company code is assigned to exactly one controlling area. The controlling area in turn can be assigned to an operating concern. This means that, indirectly, a company code is assigned to an operating concern.

Tiles that represent instances of company codes are placed on top of and within the tile that represents the controlling area to which the company codes are assigned. The tile that represents the controlling area is placed in turn on top of and within the tile that represents the operating concern to which the controlling area was assigned.

If the controlling area is hidden from view, the company code tiles lie directly on an operating concern tile.

The non-directed relationships are not shown in the following sections.
The R/3 System

The term “R/3 System” is used to refer to a physical R/3 System (R/3 database).

Graphic portrayal

Representation of the SAP R/3 System
Client

The client (logical system) is the smallest addressable entity within a distribution scenario. If data is distributed, then sender and recipient must be in different clients.

You define a client (logical system) within one physical R/3 System.

Graphic portrayal

In the graphic portrayal, the client is placed on top of and within the physical R/3 System.
Operating Concern

You define an operating concern within one client (logical system).

Graphic portrayal

In the graphic portrayal, the operating concern is placed on top of and within the client to which it is assigned.
Controlling Area

Several controlling areas can be assigned to an operating concern.

Graphic portrayal

In the graphic portrayal, the controlling area is placed on top of and within the operating concern to which it is assigned.
Company Code

Graphic portrayal

One or several company codes can be assigned to a controlling area. In the graphic portrayal, the company codes are placed on top of and within the controlling area to which they are assigned.

One or several company codes can be assigned to a company (consolidation unit). In the graphic portrayal, the company codes are placed on top of and within the company to which they are assigned.
Business area

Graphic portrayal

A business area is assigned to a client (logical system), but it is not dependent on an operating area, controlling area, company code and so on. Business areas can be used by several company codes for reporting purposes. In the graphic portrayal, these business areas are normally represented using tiles that overlap the company codes affected.
**Profit Center**

Profit centers are always assigned to exactly one controlling area. They can be grouped together as a profit center grouping.

**Graphic portrayal**

In the graphic portrayal, the profit centers or profit center groupings are contained in the controlling area.
Cost Center

Graphic portrayal

- Several cost centers can be assigned to a company code. A cost center is assigned to exactly one company code.
- A cost center can be assigned to exactly one business area to which all costs of the cost center can be attributed.
- One or several company codes can be assigned to a controlling area. A cost center is assigned to exactly one controlling area.
- A cost center can be assigned to exactly one profit center to which all costs of the cost center can be attributed.

In the graphic portrayal, the cost center is placed on top of and within the controlling area, the company code, the business area, and the profit center to which it is assigned.
**Consolidation entity**

**Graphic portrayal**

A consolidation unit can be assigned to several consolidated entities. In the graphic portrayal, a consolidation unit is placed on top of and within the consolidated entity to which it is assigned.
Consolidation Entity

Graphic portrayal

You define a consolidation entity within one client (logical system). In the graphic portrayal, a consolidated entity is placed on top of and within the client.
Plant

Graphic portrayal

Several plants can be assigned to a company code. In the graphic portrayal, the plants are placed on top of and within the company code to which they are assigned.
Purchasing Organization

Graphic portrayal

Several purchasing organizations can be assigned to a company code. In the graphic portrayal, the purchasing organizations are contained in the company codes.

A purchasing organization can purchase for several plants, or several purchasing organizations can be responsible for purchasing in one plant. In the graphic portrayal, purchasing organizations and plants are placed next to each other.

Purchasing organizations that procure for several company codes (contract management) are not assigned to one company code. In the graphic portrayal, they are therefore placed to the side of the company codes.
Sales Organization

Graphic portrayal

A sales organization is assigned to exactly one company code. A plant can be assigned to a sales organization through a distribution channel. In the graphic portrayal, sales organizations and plants are placed next to each other on top of and within the company code to which they are assigned.
Distribution Channel

Graphic portrayal

A distribution channel can be used in several company codes. In the graphic portrayal, distribution channels and company codes are placed overlapping and at right angles.

A sales organization can sell materials and services through several distribution channels. In the graphic portrayal, distribution channels and sales organizations are placed overlapping and at right angles.
Division

Graphic portrayal

A sales organization can sell material and services from different divisions.
Sales Area

Graphic portrayal

A sales area is set up for each possible combination of distribution channel, infrastructure division, and sales organization.

In the graphic portrayal, a sales area is placed on top of and within the intersection of sales organization, division, and distribution channel.
R/3 System Organizational Units Without Their Own Shape

Definition
The following sections contain an introduction to each R/3 system organizational unit that currently does not have a shape in the Structure Modeler.

Structure
The R/3 organizational units portrayed are grouped as follows:

- Cross-application organizational units
- R/3 Organizational units for Accounting
- R/3 Organizational units for Logistics
- R/3 Organizational Units for Human Resources

Cross-application organizational units
- Enterprise
- Work center

R/3 Organizational units for Accounting
- Consolidation business area
- Functional area
- Sales tax area
- Credit control area
- Dunning area
- FM area
- Funds center
- Cost center grouping
- Profit center grouping

R/3 Organizational units for Logistics
- Design office
- Plant storage area
- Maintenance planning plant
- Sales office
- Shipping point
- Loading point
R/3 System Organizational Units Without Their Own Shape

- Transportation planning point
- Material valuation area
- Warehouse complex
- Warehouse
- Storage bin
- Storage section
- Purchasing group
- Purchasing area
- Maintenance planner group
- Functional location
- Work scheduler group
- Capacity planner group
- CAPP planner group
- MRP controller group
- Production scheduler group
- Production responsibility group
- Supply area

R/3 Organizational Units for Human Resources

- Personnel area
- Personnel subarea
- Employee group
- Employee subgroup
- Payroll accounting area
- Organizational plan unit
- Position (planned)
- Job
Installing the Structure Modeler

Purpose

You use the Structure Modeler when implementing the R/3 System to portray graphically the future organizational structure (and possibly alternative structure scenarios) of an enterprise.

Prerequisites

- Installation of Visio 5.0
- Installation of the Structure Modeler
  The Structure Modeler is integrated in AcceleratedSAP (ASAP), SAP’s implementation solution.
  On the ASAP CD (Release 4.0) you can find it under: Knowledge Corner → R/3 Reference Corner → Cross Application → Structure Modeler

Procedure

1. Install Visio 5.0
2. For the sake of clarity, we recommend that you set up a new subdirectory called Structure Modeler under Solutions in the existing Visio program directory and copy the template, stencils and help texts into this directory.

Now you can create a new structure scenario.
Creating a New Structure Scenario

Use
This section describes how to create a new structure scenario in the Structure Modeler.

Procedure
1. Opening the Structure Modeler [Page 81]
2. Selecting a Language [Page 82]
3. Defining a Background [Page 83]
4. Selecting Organizational Units [Page 84]
5. Editing Drawing Pages [Page 86]
6. Creating Documentation [Page 87]
7. Creating Several Drawing Pages [Page 88]
8. Portraying Distribution Scenarios [Page 89]

To find out more about the menu functions, see:
Structure Modeler Menu [Page 90]
Alternate Mouse Button Menu [Page 93]
Opening the Structure Modeler

Procedure

2. Branch to the directory that contains the template of the Structure Modeler.
3. Select the STRUCTURE MODELER.VST file and choose Open.

Result

An instance of the Structure Modeler is started. In the left pane a stencil appears with the following SAP areas:

- Cross-application
- Accounting
- Logistics
- Human Resources

Each area contains assigned R/3 System organizational units that you may portray using the Structure Modeler.

In the right pane, a new drawing page with the SAP logo appears. Once you have created a graphic, you cannot change the Language [Page 82] or the Default gaps [Page 91].

You have now completed the steps required to create a new structure scenario.
Selecting a Language

Use
This section describes how to select the language used to display the SAP areas, the organizational units and Help.

Procedure
When you use the stencil for the first time, it is opened in English.

1. To change language, choose Structure Modeler → Language.
2. Select German or English.

The SAP areas, the organizational units and the Help appear in the language selected.

You cannot change the language for instances of organizational units that you have already created.

The Visio menu appears in the language version of Visio you have installed.
Defining a Background

Use
This section describes how to define a drawing page background to suit an enterprise’s needs, by inserting a company logo or a project code, for example.

Procedure
1. Choose Structure Modeler ➔ Options ➔ Background.

   If you want to change the layout on all drawing pages, you must enter the changes on the “logo” page. A field on the top right of the screen displays whether you are on a background (“logo”) or a foreground page.

   You can choose the following backgrounds for your drawing page:

   Default: Lets you use a standard background.

   Enterprise: Lets you define your own background.

   None: Lets you use a blank drawing page.

2. Choose Enterprise and Edit.

3. You may now enter graphics or text in your drawing page, using Insert in the Visio menu, for example.

4. Save your entries.

5. Return to a foreground page by selecting a specific Page in the field on the top right of the screen. The changes you have made in the background page now appear in the foreground page.
Selecting Organizational Units

Use
This section describes how to include the organizational units for your structure scenario in a drawing page.

Prerequisites
The following guidelines will make it easier for you to work with structure scenarios. When you portray an organizational structure in the Structure Modeler, start with instances of R/3 System organizational units nearest the bottom in the tile stack.

For example, to portray your scenario from the Accounting perspective, it is best to start by portraying the R/3 System. If you do not want the R/3 System shown, start with the operating concern.

Example: Accounting
This view contains instances of the following R/3 System organizational units:

- Client (logical system)
- Operating concern
- Controlling area
- Company code
- Business area

Procedure
1. To portray an organizational unit, point the mouse cursor to the area in the left panel to which the organizational unit you require is assigned.
2. Drag the instance of the selected area onto the drawing page. Release the mouse button. A window appears containing the organizational units assigned to this area.
Example:
The area “Cross-Application” contains the organizational unit “Client”.
The area “Accounting” contains the organizational unit “Operating concern”.

3. Choose the organizational unit you require. A tile appears on your drawing page to represent an instance of the R/3 System organizational unit.

4. You may enter data for each instance. Place the mouse cursor on the tile and press the alternate mouse button. Choose Data [Page 105] and enter the required information.

5. To display the name of the selected organizational unit, place the mouse cursor on the tile and press the alternate mouse button.
Choose Name → Show. The name proposed by the Structure Modeler is the name of the R/3 System organizational unit. You can change this name by choosing Edit on the alternate mouse button.
The name appears in a text field. You can place the text field and the related pointer wherever you wish.
Editing Drawing Pages

Use
All tiles appear standard size on the drawing page. In order to change a structure scenario clearly, you may change the size and arrangement of tiles.

Procedure
To change the size and arrangement of tiles, you have the following options:

- Use the two control handles on the tile (top right and bottom left).
  Use the control handle at the top right to change the width of the tile. Use the control handle at the bottom left to change the length of the tile.

- Press the alternate mouse button in your drawing page to obtain a list of available functions.
  To use these options, you must have created more than one instance on your drawing page.
  For more information, see: Alternate Mouse Button Menu [Page 93]

- Use the icons in the toolbox.
  For more information on the functions you may use to edit drawing pages, see: Toolbox [Page 92]
Creating Documentation

Use
This section describes how to create documentation for a structure scenario. You can record notes or explanatory texts about the structure scenarios you have created.

Prerequisites
Microsoft Word 97.

Procedure
1. Open the Structure Modeler. In the bottom left corner of your drawing page is an icon that you can use to open an MS Word document.
2. This document has a predefined structure that you can use to document your structure scenarios.
   If you wish, you may modify the structure of this document to suit your project.

Result
You may use this option to create documentation for a structure scenario. This documentation is available directly in the structure scenario drawing.

You can access the Microsoft Winword document from all drawing pages in a file.
Creating Several Drawing Pages

**Use**
You can create and edit several drawing pages within one Visio file, so you can portray structure scenarios from different viewpoints.

**Procedure**
1. Choose *Insert ➔ Page* to generate further drawing pages.
2. To move from one existing drawing page to another, choose *Edit ➔ Go to* and the corresponding drawing page or select the drawing page from the field on the top right of the screen.

To support project-related documentation that includes all views, it is possible to access any text document from all drawing pages.
Portraying Distribution Scenarios

Use
You may use standard Visio 5.0 utilities to portray distribution scenarios.

Procedure
1. Create the instances between which you would like to establish relationships or use a structure scenario you have already created.
2. Activate the Shape toolbar menu in Visio. Position the mouse pointer on a free area at the top of the Visio screen and press the alternate mouse button. Activate Shape.
3. Use the Line Tool function to draw a line to indicate a relationship between two specific instances.
4. Use the mouse to select the line. Use the Line Ends function to indicate the direction of the data exchange.
5. You can use the Text Tool function to write information next to an arrow.
The Structure Modeler Menu

Definition
You can use this menu to make key settings for the Structure Modeler, for example to set the language.

Structure
The menu consists of the following functions:

- **Language [Page 82]**: Use this function to choose either German or English as the language in which your organizational units are displayed.

- **Toolbox** Use this function to show or hide the toolbox on your drawing page.

- **Options [Page 91]** Use this function to make settings for your project, for example the distance between individual objects or project-specific layouts.
Options

Use
This section describes the functions of the Options menu item in the Structure Modeler menu.

Features

User settings:

Structure Modeler Operations: You can set the number of Undo operations (from one to nine).

Warnings You can choose whether the system should display warnings or not.

Background You can choose the following backgrounds for your drawing page:

Default: lets you use a standard background.

Enterprise: lets you use define your own background.

None: lets you use a blank drawing page.

Tile Displays the standard distances set for each option (height, gap, overlap and distance).
Toolbox

Use
This section describes the functions available in the toolbox for editing the structure scenario.

Features
Options included in the standard Visio 5.0 installation are not described here.

- Fitting tiles [Page 95]
- Aligning tiles [Page 96]
- Adapt size [Page 97]
- Overlap [Page 98]
- Move [Page 99]
- Divide [Page 100]

Using the function Foreground or Background tiles can be moved up or down one level in the stack.

Using the Undo function, you can undo activities that you have carried out from the toolbox.

Activities
To show the toolbox, choose Structure Modeler → Toolbox.
You can find out what a tool does by holding the mouse pointer over it.
The Alternate Mouse Button Menu

Definition
This section provides a list of functions that you can use to edit the structure scenario graphically.

Use
You can access all the options for changing the tiles by clicking on it with the alternate mouse button. Select a tile to change, and click on it with the alternate mouse button.

Options included in the standard Visio 5.0 installation are not described here.

Structure Modeler options include:

- Key [Page 94]
- Fitting tiles [Page 95]
- Aligning tiles [Page 96]
- Adapt size [Page 97]
- Overlap [Page 98]
- Move [Page 99]
- Divide [Page 100]
- Name [Page 101]
- Help [Page 102]
- Documentation [Page 104]
- Data [Page 105]

Using the Undo function, you can undo activities that you have carried out from the toolbox.

Functions are displayed context-sensitively, that is you are offered different functions according to whether the cursor is placed on an organizational unit or on a drawing page.

Alternatively you can display the Toolbox [Page 92] and use the function you want from there.
## Key

### Use

You can have a key automatically generated for a structure scenario that you have created using the Structure Modeler.

### Activities

<table>
<thead>
<tr>
<th>Activity</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Show/hide key     | 1. Position the mouse pointer on a free area of the drawing page and choose *Key* on the alternate mouse button.  
                      2. The key now inserted in the lower part of the drawing page contains all the system organizational units that have their own shape and that you have used in this graphic.  
                      To hide the key, choose *Key* again on the alternate mouse button. |
| Change font size  | 3.                                                                                                                                          |
| Refresh key       | 4. To refresh the key, position the mouse pointer on a blank space in the drawing page and choose *Refresh key* on the alternate mouse button. |
| Move key          | 5. Select the key with the left mouse button and hold the mouse button down.  
                      6. You can now move the key to wherever you want.                                                                                     |
| Change orientation| 7. Select the key with the right mouse button to display the function menu.  
                      8. Choose the function *Change orientation* to toggle between horizontal and vertical alignment.                                       |
Fit

Use
You choose Fit to position a newly inserted tile on an already existing tile and size the new tile to match the reference tile.

Activities
1. Select the tile that you have just inserted.
2. Then select the tile that you want to use as a reference tile.
3. Press the alternate mouse button, or use the Fit function from the toolbox.

The new tile changes to fit the reference tile.
Align

Use

You choose *Align* to align a new tile drawing page to a reference tile without changing its size. This option works whether the first tile and the reference tile are stacked or adjacent.

Activities

1. Select the tile that you want to align.
2. Then select the tile that you want to use as a reference tile.
3. Press the alternate mouse button, and choose *Align* from the menu, or choose the *Align* function from the toolbox.

The options are:

- **Right:** Aligning to right edge of reference tile
- **Left:** Aligning to left edge of reference tile
- **Front:** Aligning to front edge of reference tile
- **Back:** Aligning to back edge of reference tile

The new tile is aligned accordingly.
Adapt size

Use
You choose Adapt size to adjust the size of a new tile to the size of a reference tile. This option works whether the first tile and the reference tile are stacked or adjacent.

Activities
1. Select the tile that you want to adjust.
2. Then select the tile that you want to use as a reference tile (that is a tile of precisely the size you want).
3. Press the alternate mouse button, and choose Align from the menu, or choose the Adapt size function from the toolbox.
4. The Structure Modeler options are:
   - Width: You change the width of the tile, but not its depth.
   - Depth: You change the depth of the tile, but not its width.
   - Both: You change both the width and the depth of the tile.
   - Right: The new tile grows to the right edge of the reference tile. The left edge of the new tile does not change.
   - Front: The new tile grows to the front edge of the reference tile. The back edge of the new tile does not change.

The new tile is adjusted accordingly.
Overlap

Use

You choose Overlap to position a tile so that it overlaps one or more tiles at right angles.

Activities

1. Select the tile that will overlap.
2. Select one or more tiles to be overlapped.
3. Press the alternate mouse button, and choose Overlap from the menu, or choose the Overlap function from the toolbox.
4. Choose horizontal to make the new tile overlap the other tile or tiles in the horizontal plane.
5. Choose vertical to make the new tile overlap the other tile or tiles in the vertical plane.
Move

Use
You use Move to position a selected tile on the drawing page accurately.

Activities
There are two Structure Modeler options for this function.

- To move tiles back or forward on the same level in small steps on the drawing page:
  Choose Move → Back or Move → Forward using either the function key or the menu function.

- To move stacked tiles up (and make them smaller) or down (and make them bigger):
  Choose Move → Up or Move → Down using either the function key or the menu function.
Divide

Use
You use Divide to divide the selected tile into several equally sized pieces. You can choose to divide the tile vertically or horizontally.

Activities
1. Select the tile that you want to adjust.
2. Press the alternate mouse button, and choose Divide from the menu, or choose the Divide function from the toolbox.

If dividing the tiles would make them smaller than the minimum size you will receive an appropriate message and the operation will not take place.
Name

You use the Name and Notes function to give the selected tile a name. A text field appears on the drawing page, with a pointer to the instance concerned. The name proposed by the Structure Modeler is name of the underlying system organizational unit. Use the standard Visio functions to edit the name.

The text is connected to the instance to which it refers with an arrow. You can place the text field and the related pointer wherever you wish. Select the text field and hold down the left mouse key. You can then move the text field with the cursor.
Help

Use

You choose Help to read the Help on currently selected tiles or their underlying system organizational units.

This function is simply a description in the form of a table; it is not linked to the R/3 System. This table should be seen as additional support, not as an instruction manual.

The creator of the structure scenario is responsible for the accuracy and completeness of the organizational units and the relationships between them, and should ensure that the graphical representation corresponds to the business context in the R/3 System.

Features

On the top line you see the name of the R/3 system organizational unit you have selected You can now choose one of two options:

- Active organizational unit
  By choosing this option you can see the R/3 organizational units on which the selected R/3 organizational units can be placed (on the left of the screen).
  The "x" under "preferred" designates those system organizational units on which the selected system organizational unit is usually placed.
  On the right, those R/3 system organizational units are listed that the selected R/3 system organizational unit may overlap.

- Reference organizational unit
  By choosing this option you can see the R/3 organizational units that can be placed on the selected organizational unit (on the left of the screen).
  The "x" under "preferred" designates those system organizational units that can be placed on the selected system organizational unit.
  On the right, those R/3 system organizational units are listed that the selected organizational unit may overlap.
### Structure Modeler: Company Code

<table>
<thead>
<tr>
<th>Repository level</th>
<th>Preferred</th>
<th>Overlaps</th>
</tr>
</thead>
<tbody>
<tr>
<td>R/3 System</td>
<td></td>
<td>Business area</td>
</tr>
<tr>
<td>Client</td>
<td></td>
<td>Profit Center</td>
</tr>
<tr>
<td>Consolidation entity</td>
<td></td>
<td>Other unit</td>
</tr>
<tr>
<td>Consolidation unit</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Operating concern</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Controlling area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profit center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other unit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Active OUs**

**Repository level**

**Preferred**

**Overlaps**

- Business area
- Profit Center
- Other unit

**Reference OUs**

**Repository level**

**Preferred**

**Overlaps**

- Business area
- Profit Center
- Other unit

**Close**
Documentation

Use
You choose Documentation to see documentation of a currently selected tile or its underlying system organization unit. The documentation describes the current instance from a business perspective.

Prerequisites
You have installed Microsoft Word 97.
Data

Use
You can use this function to create enterprise-specific data for individual instances.

Prerequisites
You have created at least one instance of an organizational unit on your drawing page.

Features
For each instance of an organizational unit you can open a specific screen template and enter specific values in it.

Activities
1. Select the instance and choose Data on the alternate mouse button.
2. The system displays an input screen containing the fields that need to be maintained for the object you have chosen.

You can make the following entries for the cost center organizational unit:
- Cost center identification
- Cost center name
- Currency
- Comment

1. Enter text and values as required.
2. Confirm your entries
Enterprise Modeling Procedures

Definition

To map your enterprise structure you carry out a series of tasks using SAP’s R/3 implementation methodology AcceleratedSAP (ASAP)– for projects with relatively limited scope – or Global ASAP for groups with global interests.

Use

Both Global ASAP and ASAP include work packages, activities, and tasks that describe what you need to do to implement R/3. They also offer information that makes it easier for you to carry out individual project steps, for example:

- documents that may provide helpful input
- the deliverables from each task or activity
- templates, which you can use for documentation
- the estimated duration of each task
- a list of those responsible for carrying out the task

This is why you should also take the project-oriented enterprise modeling procedure directly from ASAP or Global ASAP. In Global ASAP [Page 111] and ASAP [Page 107], there is a list and short description of the work packages in which you use the Structure Modeler to map your enterprise structure.

You can then use the enterprise models you have created as inputs to other work packages.
ASAP

Definition

AcceleratedSAP (ASAP) is SAP’s standard implementation methodology. It contains the ASAP Roadmap, a step-by-step guide with links to tools and services to assist all team members in implementing R/3.

ASAP is delivered as a PC-based package, so that you can begin your implementation project prior to having an R/3 System installed.

For further information on ASAP, see the AcceleratedSAP function brochure.

Use

Enterprise modeling, that is mapping the enterprise structure you have (or plan to have) to R/3 organizational units and their structures, is also integrated in the ASAP Roadmap.

The Structure Modeler is the tool that SAP provides for portraying your enterprise structure. You can use the Structure Modeler to create and compare alternative structure scenarios and then choose the one that suits you best. It also lets you portray your enterprise structure as a distributed system infrastructure (for example, using ALE).

Structure

The following list indicates the phases, work packages, and activities in the ASAP Roadmap that deal with enterprise modeling:

- **Phase 1: Project Preparation**
  Work package Define System Landscape Strategy [Page 108]

- **Phase 2: Business Blueprint**
  Work package “Business Organization Structure”

- **Phase 3: Realization**
  Work package “Configure Initial Settings and Organizational Structure”
  Activity “Establish Organizational Structure [Page 110]”

You should also use graphical structure models for the following:

- Determining business processes and master data
- Reporting
- Training
- Documentation
- The quality check
Define System Landscape Strategy

Definition
The purpose of this activity is to establish an implementation strategy for the system landscape.

Use
Tasks include:
1. Define required systems
2. Determine client deployment strategy
3. Define release strategy
4. Define transport system strategy

Modeling your system landscape graphically using the Structure Modeler helps you to ensure that you have not forgotten any fundamental system requirements; that you have documented all the changes made in Customizing and development; and that you have these changes to the appropriate systems.
Define Business Organization Structure

Definition

This activity in the ASAP Roadmap describes what you need to do, to define the enterprise-specific structures and business processes using R/3 organizational units.

There are four tasks in this activity:

1. Plan organizational structure workshops
2. Distribute organization structure guidelines
3. Conduct organizational structure workshops
4. Recommend and approve organization structure

Use

The ASAP Roadmap texts offer detailed recommendations on how to carry out the appropriate tasks; to compile the necessary information; to document that information graphically; and to decide between possible alternative structures.

It is important that you determine the definitive structure for your enterprise in this activity. You can then start defining business processes as your next step.
Establish Organizational Structure

Definition

The purpose of this task is to create organization unit settings in your R/3 System using the Implementation Guide (IMG). These settings are determined in Phase 2: Business Blueprint.

Use

Organizational unit settings are critical for the configuration of your processes and functions. Use the documented R/3 Organization Structure for the company as input for configuration.
Global ASAP

Definition

In contrast to the AcceleratedSAP Roadmap which only supports one implementation strategy, Global ASAP must support various R/3 implementation strategies, which may contain different methods.

The basic concept of Global ASAP is to define and carry out centrally for the whole group all activities that take place at global level. These groupwide activities are then mapped to the new Global Roadmap which provides solutions and input for the projects at the regional and local levels (rollout).

For further information on Global ASAP, see the AcceleratedSAP function brochure.

Use

The Global ASAP methodology includes:

- Maintaining organizational and data structures and ensuring that business cases are consistent
- Setting up distributed systems
- Carry out change management tasks.

Structure

The following phases, work packages, and activities in the Global ASAP Roadmap deal with enterprise modeling:

- **Phase 1: Global Program Set Up**
  - Work package: Define Global Strategy
  - Activity: Perform Strategy Selection Study
  - Task: Develop Organizational Structure [Page 113]

- **Phase 2: Global Business Blueprint**
  - Work package: Global Business Process Definition
  - Activity: Conduct Global Business Process Workshops (Level II)
  - Task: Analyze Business Entities [Page 114]

- **Phase 3: Global Realization**
  - Work package: Configure Initial Settings and Org. Structure for Template
  - Activity: Establish Organizational Structure [Page 115]

You should also use structure models for:

- Determining business processes and master data
- Reporting
- Training
- Documentation
- Quality check
Develop Organizational Structure

Definition
The purpose of this task is to identify requirements that may affect the definition of R/3 System organizational units.

Use
You use the Structure Modeler to create a structure scenario that forms the basis for implementing the R/3 System. In this step, structure modeling is treated from a strategic point of view.

You concentrate on developing one or more structure scenarios founded on a pure business-oriented basis. You ignore distribution aspects at this stage; you may deal with them later.
Analyze Business Entities

Definition
In this phase, the final enterprise structure model is developed, documented, and agreed. It is important to identify and recognize further requirements and the impact of subsequent changes in organizational and process structures.

Therefore, you should draw up an enterprise structure model based on the R/3 System organizational units as early as possible in the Global Business Blueprint phase, ideally before a prototype is defined. You should only make minor changes in the Global Realization phase.

Structure
To create an enterprise model:
1. Become familiar with the organizational units in the R/3 System
2. Test the organizational structure from Phase 1
3. Define global and local organizational units
4. Draw a structure model for the organizational structure.
Establish Organizational Structure

In Phase 3, you create organizational structures using Customizing activities in the R/3 System.
Structure Scenarios: Examples

Purpose
You can use structure scenarios to portray the overall organizational design for your R/3 System and to help you outline your enterprise-specific requirements.

Features
In a structure scenario, the organizational units in the R/3 System (for example, company codes, business areas, or plants) are used to portray the legal entities, areas, business locations, and so on of an enterprise. The overall structure of the enterprise is represented by the way in which these organizational units are linked and assigned.

There are several types of structure scenario, including:

- Business Area Scenarios
- Company Code Scenarios
- Profit Center Scenarios
The Example Enterprise

The following structure modeling example concerns a fictitious hardware manufacturer. Sapo manufactures and distributes PCs, printers, and monitors. It consists of three legally independent companies.

- Sapo Czech Republic manufactures printed circuit boards in four different locations. It supplies two German manufacturing facilities, which produce printers (Hannover) and PCs (Munich).
- Sapo Germany includes these two facilities and a plant in Berlin, which manufactures monitors.
- Sapo Ireland manufactures casings for PCs, printers, and monitors. It supplies the three German facilities.
- Sapo buys keyboards from a third-party supplier.

Modeling is limited to this example; no attempt has been made to include all the Enterprise Modeler’s options. Instead, the example shows you how to use structure modeling to portray a conceptual design (the Business Blueprint) that meets your needs. You can portray and analyze enterprise structures in different scenarios. This will enable you to map your requirements to R/3 organizational units as closely as possible.

The structure of the example enterprise is portrayed in the following ways:

- **Business Area Scenario** [Page 118]
- **Company Code Scenario** [Page 133]
- **Profit Center Scenario** [Page 145]
Business Area Scenario (Business Area)

Business area scenarios differ from company code scenarios in the way in which they display strategic business units. In business area scenarios, business areas are used to represent strategic business units. In the following topics we introduce and analyze an outline business area scenario for Sapo the example enterprise [Page 117]:

System Infrastructure [Page 119]
Legal Entities [Page 120]
Strategic Business Units [Page 121]
Profitability Analysis [Page 123]
Cost Accounting [Page 124]
Plant Structures [Page 125]
Purchasing [Page 126]
Sales [Page 127]
System Infrastructure (Business Area)

The business area scenario for Sap so is set up in a central R/3 System. All the business application components are created in a production client. This means that you can use all the R/3 System's functions and reporting options centrally. You do not need to take distributed system issues into account.
Legal Entities (Business Area)

Company codes are used to represent legal entities in business area scenarios. You need to define the following individually for each company code:

- Reports for external rendering of accounts (financial statement, profit and loss statement, tax reports, and so on) are prepared separately for each company code
- Asset accounting, open item accounting, dunning procedures, bank accounting

Each of the three legal entities – Sapo Ireland, Sapo Germany, and Sapo Czech Republic – is portrayed as a separate company code:

For more information on mapping legal entities in the company code scenario, see also: Legal Entities (Company code) [Page 136]
**Strategic Business Units (Business Area)**

Strategic business units in business area scenarios are represented using business areas, which can be defined across company codes.

In Sapo the example enterprise there are three areas of responsibility, portrayed using the three business areas PCs, printers, and monitors. You could refine the structure further by defining business areas for printed circuit boards and casings. This would allow you to create reports specifically for these two products. However, you will not be defining these additional business areas in this example, since the enterprise structure would then become too complicated.

Sapo Czech Republic supplies German manufacturing facilities with printed circuit boards for PCs and monitors. However, it does not produce printed circuit boards for monitors, nor does it perform any other activity (such as procurement or sales) in this business unit.

If you intend to generate internal business unit financial statements using the standard financial statement report in G/L accounting, you should note the following:

- All the company codes to which a specific business area is assigned must use the same operational chart of accounts. The operational chart of accounts specify the structure of the G/L accounts of a given company code, along with the cost element structure of the controlling area to which that company code is assigned.

- Country-specific requirements (for the chart of accounts and for the report structure for external rendering of accounts) can be fulfilled using the country-specific chart of accounts. That is, Sapo Ireland, Sapo Germany, and Sapo Czech Republic use the same operational chart of accounts but differing country-specific charts of accounts.

- Value flows needed for consolidation purposes are not permitted between companies in the same business unit. For Sapo the example enterprise this means that the delivery of printed circuit boards and casings can only be valued at the cost of goods manufactured. Transfer prices that differed from the cost of goods manufactured would lead to distortions in the
Strategic Business Units (Business Area)

internal business unit financial statements. You can perform profitability analyses for the supplier companies Sapo Czech Republic and Sapo Ireland only if you have also created a profit center scenario [Page 145].
Profitability Analysis (Business Area)

You define a central operating concern for Sapo the example enterprise. This allows you to carry out cross-company, enterprise-wide evaluations. Before you create this central operating concern however, you must segment the enterprise’s sales markets.

Profitability segments (market segments) are defined in Sapo using a combination of characteristic values:

- Sales market: Taiwan, Europe, USA, Japan, Czech Republic
- Strategic Business Units: PCs, printers, monitors, printed circuit boards, casings
- Distribution channel direct sales, wholesale trade, retail trade
Cost Accounting (Business Area)

Since the management at Sapo has decided to use a single enterprise-wide cost reporting system, one central controlling area has been created. There are two prerequisites for representing the enterprise in this way:

- Cost type structures and cost center structures between legal entities have been reconciled.
- All the company codes use the same operational chart of accounts and a uniform fiscal year division.

The controlling area lies on and inside the operating concern tile, because each controlling area must be assigned to a complete operating concern. You may only adopt central cost accounting in conjunction with central profitability analysis. You can assign several controlling areas to one operating concern.
Plant Structure (Business Area)

You must pay particular attention to your requirements for production planning and inventory management when you define plants and map your business and plant location structures of your enterprise to the R/3 architecture. The plant structure does not necessarily correspond to the business location structure of the enterprise:

- Sapo the example enterprise makes printed circuit boards for printers and PCs in four locations in the Czech Republic. Requirements and production planning are carried out centrally in Germany. The four locations are therefore portrayed as a single cross-business area plant.
- The Ireland location, which makes casings for PCs, printers, and monitors, is portrayed as a single cross-business area plant.
- The Munich location builds branded PCs, servers, and "no name" PCs. They want to carry out material requirements planning and detailed production planning for each market segment independently. The Munich location is therefore portrayed as three business area-specific plants.
- The Hanover (printers) and Berlin (monitors) locations are also portrayed as two separate business area-specific plants.
Purchasing (Business Area)

In Sapo the example enterprise, external procurement – that is the purchase of materials from external vendors – can be organized at three levels in the R/3 System:

- Plant-specific
- Cross-plant
- Cross-company code

Purchasing in Ireland and the Czech Republic is organized in a plant-specific way. You set up a purchasing organization for each of the two plants. This purchasing organization is responsible for the plant assigned to it.

In Germany, purchasing is organized in a cross-plant structure for all the German plants Hanover, Berlin, and Munich. A single purchasing organization is created for all five plants.

Sapo also creates a single cross-company code purchasing organization, which can procure materials for each plant in each legal entity. This purchasing organization concludes group contracts and can negotiate for favorable conditions, since it is purchasing large quantities.
Sales (Business Area)

You use *sales organizations* to define your basic sales and distribution structure. Then you create *sales organizations* the organizational and legal structure of sales and distribution are very important.

You use *sales areas* to define your detailed sales and distribution structure. You can define customer-specific master data (conditions, rebates, and so on) and aspects of integration (rules for deriving business area account assignments) at this level.

You integrate your sales and distribution structure with your financial accounting and materials management systems using the *division* and *distribution channel* organizational units. Each *division* and *distribution channel* is assigned to the appropriate *sales organization*.

For more information on the organization of sales in the example enterprise, see:

- Divisions [Page 128]
- Sales Organizations [Page 129]
- Distribution Channels and Sales Areas [Page 130]
Divisions (Business Area)

You must assign your material stocks to strategic business units, before you assess the profitability of that business unit using key figures.

In Sapo the example enterprise, business premises in the Czech Republic and Ireland are portrayed as cross-business area plants. As a result, you cannot guarantee that material stocks are assigned to exactly one business area in each case. You also need to define divisions (product groups), each of which you then assign to a single business area.

Sapo creates the divisions PCs, printers, and monitors, and then assigns each of them to exactly one business area. All the material stocks are then assigned to exactly one division. In this way you can derive the assignment of material stocks to business areas from the division, even if you have set up cross-business area plants.

If materials are used in several different business areas, and consequently cannot be assigned to only one, these materials must be assigned to business area-specific plants.
Sales Organizations (Business Area)

In Sapo the example enterprise there is a cross-business area sales structure. You create a sales organization for Sapo Czech Republic, Sapo Germany, and Sapo Ireland. All the revenues generated by processing sales orders and invoices within a sales organization are posted as a receivable within the company code to which that sales organization is assigned.

For more information on cross-company code sales order processing see also:
Cross-Company Code Sales (Company Code) [Page 144]
Distribution Channels and Sales Areas (Business Area)

Distribution channels

You assign each plant to a combination of distribution channel and sales organization, so that you can process shipping of materials. You use this assignment to specify the sales organizations that can process the sale of materials from a plant and the distribution channels that you can use to deliver the material. Different sales organizations can use a given distribution channel. Sapo uses three distribution channels: the retail trade, the wholesale trade, and direct sales – except Sapo Ireland, which uses only the retail trade.

Sales areas

Each sales area is a specific combination of a sales organization, a distribution channel, and a division. Sales organizations are divided into sales area, so that you can specify responsibility for materials, which are assigned to a particular division and distributed using a particular distribution channel.

(Since business areas and divisions are defined without reference to distribution channels, they are not displayed in the following graphic for the sake of clarity).

In Germany and the Czech Republic, Sapo uses all three distribution channels: retail trade, wholesale trade, and direct sales. However servers from the Munich plant are only delivered through the wholesale trade and direct sales channels, while "no name" PCs from that plant are sold only to the wholesale and retail trade.
Consequently, the following sales areas are generated:

1. Ireland - wholesale trade - PCs
2. Ireland - wholesale trade - printers
3. Ireland - wholesale trade - monitors
4. Germany - wholesale trade - PCs
5. Germany - wholesale trade - monitors
6. Germany - wholesale trade - printers
7. Germany - direct sales - PCs
8. Germany - direct sales - monitors
9. Germany - direct sales - printers
10. Germany - retail trade - PCs
11. Germany - retail trade - monitors
12. Germany - retail trade - printers
13. Czech Republic - wholesale trade - PCs
14. Czech Republic - wholesale trade - printers
15. Czech Republic - retail trade - PCs
16. Czech Republic - retail trade - printers
17. Czech Republic - direct sales - PCs
18. Czech Republic - direct sales - printers

*Sapo Germany company code: detailed view:*
Distribution Channels and Sales Areas (Business Area)

- Plant: branded PCs, Munich
- Plant: printers, Hanover
- Plant: "no name" PCs, Munich
- Plant: servers, Munich
- Sales organization: Germany
- Division: printers
- Division: PCs
- Distribution channel: direct sales
- Distribution channel: retail trade
- Distribution channel: wholesale trade

Key:
- Company code
- Division
- Sales area (SA)
Company Code Scenario (Company Code)

A company code scenario has been created for Sapo, the example enterprise [Page 117] as well as a business area scenario.

A separate company code is created in the company code scenarios for each point of intersection between a legal entity and a strategic business unit. The company codes of a strategic business unit or legal entity can be consolidated to form a subgroup at the end of the period for internal or external reporting purposes.

For more information on the company code scenario for the example enterprise, see also:

System Infrastructure [Page 134]
Strategic Business Units [Page 135]
Legally Independent Companies [Page 136]
Cost Accounting and Profitability Analysis [Page 138]
Consolidated Individual Account Closing [Page 139]
Consolidated Business Unit Closing [Page 140]
Plant Structures [Page 141]
Purchasing [Page 142]
Sales [Page 143]
System Infrastructure (Company Code)

The company code scenario for Sapo is set up in a central R/3 System. All the business application components are created in a production client. This means that you can use all the R/3 System's functions and reporting options centrally. You do not need to take distributed system issues into account.
Strategic Business Units (Company Code)

Strategic business units are represented by company codes in company code scenarios. This means that you can only work within business units when you use, maintain, or create instances for any of the following in the R/3 System:

- Open item management, bank and asset accounting, credit limit checks
- Profitability controlling, cost controlling
- Inventory management, production planning, sales

There are three business units in Sapo the example enterprise: PCs, printers, and monitors.
Legal Entities (Company Code)

Legal entities are represented by company codes in company code scenarios. The independent accounting unit in these scenarios is either the company or the subgroup.

Eight company codes are created for Sapo. That is, a company code is created at every point of intersection between a legal entity and a strategic business unit.

You do not create a company code for the intersection between the business unit monitors and the company Sapo Czech Republic, because Sapo Czech Republic does not manufacture printed circuit boards for monitors.

- Sapo Ireland
- Sapo Germany
- Sapo Czech Republic

R/3 System

Company code

For more information on mapping legal entities in the business area scenario, see also:
Legal Entities (Business Area [Page 120])

Structuring your enterprise using the company code scenario does increase the complexity of your organizational structures and business processes, but for the example enterprise it makes sense for the following reasons:

- Subdividing the enterprise into autonomous business units allows you to set up and optimize each business unit independently for strategic purposes.
- You can account for delivery of printed circuit boards and casings to German plants using separate transfer prices. You set up a relationship between internal customers and internal suppliers.
- At Sapo, externally salable products (casings, printed circuit boards) are created at different stages in the value chain. This means that there are specific external procurement and sales...
markets at certain value chain stages. In the company code scenario you can compare prices, manufacturing costs, and potential yield of circuit boards or casings with those of other manufacturers.

- This can increase your flexibility in procurement. For example if there is a stoppage at the Czech manufacturing facilities, or if casings cannot be procured internally under the usual market conditions, casings and printed circuit boards can be obtained from an external supplier.
- You can monitor cost factors for each stage in the value chain.
- You can make strategic investment and disinvestment decisions without having to make major changes to your organizational structure. So for example Sapo could sell its printed circuit boards or casings manufacturing facility without any difficulty.
Cost Accounting and Profitability Analysis (Company Code)

Sapo has decided to use central cost accounting and profitability analysis, so that they can carry out unitary cost reporting and enterprise-wide evaluation.

To find out more about the prerequisites for central cost accounting and profitability analysis, see:

Cost Accounting (Business Area) [Page 124]

Profitability Analysis (Business Area) [Page 123]

Central cost accounting is depicted in a controlling area, while central profitability analysis is depicted in an operating concern. The controlling area tile lies on and inside the operating concern tile.
Consolidated Individual Account Closing (Company Code)

If a value flow relevant for consolidation purposes has taken place between the business units of a legal entity during the accounting period, the intercompany sales and profits must be eliminated so that you can carry out the statutory individual account closing activities.

For consolidation purposes, a company is first created for each company code in the enterprise. The companies within a legal entity are then consolidated to form a subgroup.

In Sapo the example enterprise, a company is set up for each company code and a subgroup is set up for each legal entity (Ireland, Germany, Czech Republic).
Consolidated Business Unit Closing (Company Code)

To perform consolidated business unit closing activities, a company is first created for each company code of the business unit. The companies within a business unit are then consolidated to form a subgroup. Intercompany profits – arising from materials sold from one legal entity to another within a single business unit – are eliminated in the subgroup closing.

In Sapo the example enterprise, a company is set up for each company code and a subgroup is set up for each legal entity (Ireland, Germany, Czech Republic). All the companies in a business unit are assigned to one of these subgroups.
Plant Structure (Company Code)

In company code scenarios, plants are always defined on a business-unit-specific basis or in an even more finely differentiated manner. This is necessary because a company code is defined for each point of intersection between a legal entity and a business unit and because each plant must always be assigned to exactly one company code.

Thus you define three plants for the example enterprise Sapo Ireland and two for Sapo Czech Republic, even though you only had to define one plant for each legal entity in the business area scenario.

See also:
Plant Structure (Business Area) [Page 125]
Purchasing (Company Code)

Since a purchasing organization can be assigned to several company codes, you need to define both cross-plant and cross-company code purchasing organizations for the Czech Republic, Ireland, and Germany.

You also need to define a central, cross-company code and cross-business unit purchasing organization for Sapo.
Sales (Company Code)

You cannot create a sales organization that crosses business areas, since each sales organization must be assigned to exactly one company code.

See also:

Sales Organization (Business Area) [Page 129]
Cross-Company Code Sales (Company Code)

You can process customer orders that cross business-areas by assigning plants to sales organizations that cross company codes.

In our example, each plant (for the business areas of PCs, printers, and monitors) is assigned to a sales organization within that organization's company code. At the same time, all the German plants are assigned, cross-company code, to the appropriate sales organization—that is, the one that is itself assigned to the company code for Germany-PCs.

Sapo Germany: the detailed view:

For example, if a customer orders a branded PC and monitor, the order can be processed using Sales Organization 1.

- The branded PC is delivered from Plant 1 from its own business area, while the monitor is delivered from Plant 5 from Sales Organization 3 (Monitors).
- Sales Organization 1 creates the customer billing document for both order items.
- The customer pays Sales Organization 1 the amount he is billed for the branded PC and monitor.
- Sales Organization 3 sends an internal billing document to Sales Organization 1 for delivery of the monitor (since they have an internal customer-supplier relationship).
Profit Center Scenarios

The profit center scenario portrays internal areas of responsibility and management structures. You can define these without reference to legally independent enterprise units. In this scenario both external sales and internal deliveries of goods and services between profit centers are taken into account. When you perform profits analysis, you can value material stocks and movement of goods between profit centers using an internal valuation approach, which you can conduct along with a legal valuation approach.

Using transfer prices you can work within a controlling area that has several profit centers assigned to it. Valuation takes place at the level of the company code or plant. We recommend defining the plant (in Customizing) as the valuation level at which parallel valuation of material stocks is carried out.

You may wish to set up profit centers for Sapo, the example enterprise, particularly if you intend to portray the enterprise structure in a business area scenario [Page 118]. In the business area scenario you can only value services between companies using the cost of goods manufactured method. Therefore, you can only report internal earnings – from, for example, intermediate products like casings and printed circuit boards – in a profit center scenario.

You can depict profit center hierarchies using either:

- Tree Structure [Page 146]
- Tile representation [Page 147]
The Profit Center Hierarchy as a Tree Structure

[Diagram showing the hierarchy of Sapo, Sapo Ireland, Sapo Germany, Sapo Czech Republic, with categories of PC casings, Printer casings, Monitor casings, PC printed circuit boards, Printer printed circuit boards, PCs, Monitors, Printers, Branded PCs, "No name" PCs, Servers, Laser printers, Inkjet printers, Color printers, Black and white printers.

Sapo
  └── Sapo Ireland
        ├── PC casings
        │       └── Branded PCs
        │           ├── "No name" PCs
        │           └── Servers
        └── Printer casings
              └── Laser printers
                   └── Color printers

Sapo Germany
  └── Monitor casings
        └── Black and white printers

Sapo Czech Republic
  └── PC printed circuit boards
        └── Inkjet printers
             └── Black and white printers

Printers
  └── Printer printed circuit boards
       └── Color printers

PCs
The Profit Center Hierarchy as a Tile Representation

You can outline the following profit center scenario for Sapo, based on the hierarchically structured profit center.
To evaluate the profits from movement of goods between profit centers you need to define relationships between internal customers and internal suppliers.

Delivery of printed circuit boards from the Czech Republic to the Hannover plant is represented in the business area scenario as a stock transfer between plants. The printed circuit boards are valued in the external rendering of accounts as the cost of goods manufactured. In the profit center scenario, the profit center in the Czech Republic is the supplier while the profit center in Hannover is the customer. A sale of printed circuit board occurs in the internal currency that has been defined for all the profit centers in the enterprise.